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A Name is given to a range of cells that we use often. We could give it a name, Sales for example.
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· Place the cursor in say cell C4 and type in:      = sum(Sales)
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Hints: 
1. Individual cells can be named. eg name cells a, b & c and then they can be used in a formula  eg = 2 * a * b + c.

2. If we try to name a cell which is adjacent to a cell with text in it….
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Beware: When re-defining a name – selecting a new range on the s/sheet and giving it the name..

Formulas




To Find the Average

· Type in the 3 numbers as shown below. (The average of these 3 numbers is of course 2.)
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Formulas (Financial)

. 

Let’ say that we take out a loan for £2000.

We wish to pay off the loan in one year - making 12 monthly payments.

The interest rate we are told is 10%.

How much do we have to pay back each month?

(This is a very complicated calculation since we are paying interest on the amount left to pay!).

(The answer is £175.83 per month)

[image: image91.png]PivotTable Field
Name: [vear

Subtatals
€ Automatic
 custom
 flore

oroduct -]

T~ show items with no data

ok

Cancel
e

Adysnced.
Layout,

Humber,

FIERELE.




Let’s get Excel to work it out.

· Make up the following table
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Exercise:
Calculate the total interest paid. What percentage is this of the 2000?. Why is it less than 10%?

Optional: Make a table (an amortization table) to show the monthly payments, the interest accrued for that month ,the corresponding loan amount still outstanding and the monthly payment (which could be further split into interest payment and principle repayment.) The amount outstanding must be zero at the end of the 12th month.
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Fitting the Data onto One Printed Page
For the exercise, drag some data so that 4 pages are being used.
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· Select File, PageSetup… from the menu bar.
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· If you take a look at your spreadsheet, the dotted lines(page breaks) should have disappeared.

· This can be confirmed by clicking View, Page Break Preview. 
Worksheet Protection

We can protect the whole sheet as follows:
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But what if we don’t wish certain areas/values of the sheet to be protected and others unprotected?

· Chose the cell/range that you don’t wish to be protected.

· Format a cell as Unlocked, right-click on it and choose Format Cells. (Or on the ribbon from the Format tab on the Cells group) etc.

· [image: image128.png]


Choose Format, Cells…  and…
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Now after protecting the sheet (as shown at the top of this page) we find that we can thenonly change the unlocked cell/s.
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So unlocking cells produces a “mask” of unlocked cells.

Unprotect the whole sheet before proceeding.

Pivot Tables cont'd

You should now have the following pivot table.

· If not, copy into Excel from this word table and make the pivot table below.

	Store
	Dept
	Sales

	New York
	Food
	10.000

	New York
	Clothing
	20,000

	London
	Food
	25,000

	London
	Clothing
	12,000
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To refresh the pivot table

Notice that the pivot table does not automatically update.
· Make sure that the cursor is in the pivot table.

· On the Pivot Table toolbar, click Pivot Table, Refresh 
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Notice how the new Ribbon group for the Pivot Table appears when the cursor is in the pivot table:
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eg we could Refresh using this.
The pivot table data should now appear refreshed as below:
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To Add a New Data Row
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· To remove fields, simply click in the pivot table.  Uncheck them in the PivotTable Field List dialog box (If this is not visible right-click in the pivot table and choose Show Field List) or uncheck then in the Row Labels drop-down.
· Moving the pivot table. Simply drag it!
· Removing Grand Totals. Right click on “Grand Total” !  in the pivot table and choose Remove Grand Total.
Pivot Table Options, can also be obtained by right-clicking on the pivot table and choosing  PivotTable Options and eg “Totals & Filters” will give access to Grand Totals.
· Interchange the Store and Dept fields:. 
Simply drag them across in the PivotTable Field List dialog box.

Changing Your View of the Data Using Page Fields

· Make sure that the cursor is in the pivot table. Then in the Pivot Table Field list:
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Your pivot table should now look like this:

Changing the Summary Function for the Data
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Changing the Data to Percentage (of Total)
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Result:
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For the next exercise:

· Restore the pivot table.

To Insert a Calculated Field

It may be simpler to include a calculated field in the original data source but maybe that is inaccessible.
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· Fill in the dialog box as below and click Add.
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To Hide Pivot Table Items
We wish to hide the Clothing field
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You should find that the Clothing field is hidden as below:
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Note that the totals change. They do not take into account the hidden fields.

To Unhide a Hidden Field

· Repeat the process – choose the Dept drop down but  check the Clothing check box.
Displaying the Source Data for an Item in the Pivot Table

· Double-click on a data item.
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This should produce the following data - on a separate sheet!

This is giving an indication of how the figure of 25000 was derived!
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Sorting : Click A-Z.

Charting : Remove the Grand Totals first.

Changing the Name of Fields:

· Right-click  on the field name that we wish to change in this case Dept.
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(This changes the field name in the pivot table only not in the original table.)
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Grouping Items 


	Store
	Dept
	Sales

	New York
	Food
	10000

	New York
	Clothing
	20000

	London
	Food
	25000

	London
	Clothing
	12000

	New York
	Beverages
	23000

	London
	Beverages
	12000


· First produce this pivot table.

We wish to group the Beverages and Food categories (and call them Consumables)..

· In the pivot table highlight the Beverages and Food categories (use the Crtl-key if they are not contiguous).

· Then Right-click on one of the selected categories and choose Group,





or may look something like this in Excel 2007+

To Hide Detail








· To unhide, double-click again.

· Rather curiously, double-click on the clothing heading…. 



Exercise: 
Add to the table as shown below…

	Year
	Store
	Dept
	Sales

	1991
	New York
	Food
	1000

	1991
	New York
	Clothing
	20000

	1991
	London
	Food
	25000

	1991
	London
	Clothing
	12000

	1991
	New York
	Beverages
	23000

	1991
	London
	Beverages
	12000

	1992
	New York
	Food
	10000

	1992
	New York
	Clothing
	20000

	1992
	London
	Food
	25000

	1992
	London
	Clothing
	12000

	1992
	New York
	Beverages
	23000

	1992
	London
	Beverages
	12000


…and produce the corresponding pivot table:
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.

Exercise: 
Double click on the years (1991 & 1992) to hide the detail.

eg Reverse the Store and Year fields by dragging.

To Hide Subtotals








The dialog box which appears is a little different to that which appeared before….




Subtotals gone:
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(Recall that Grand Totals are switched off through Table Options.)

Slicers 

(New to 2010) 

First make the pivot table from this table.

	Store
	Dept
	Sales

	New York 
	Food
	10,000

	New York 
	Clothing
	20,000

	London 
	Food
	25,000

	London 
	Clothing
	12,000


· With the cursor in the pivot table, from the context ribbon menu Options choose Insert Slicer.







The pivot table now automatically shows results only for the London Store.


Exercise: Make a slicer for the Dept.
 (You can have both (Store & Dept) showing at the same time)

Pivot Chart
	Store
	Dept
	Sales

	New York 
	Food
	10,000

	New York 
	Clothing
	20,000

	London 
	Food
	25,000

	London 
	Clothing
	12,000


· With the cursor in the table above, choose Insert Pivot chart:



Follow the usual procedure as for the pivot table.

Our pivot chart eventually appears below. 






Exercise: Make some slicers and not how the chart responds as well!

Exercise.

· 1. A man works 35 hrs in a particular week. He gets paid £4.00 per hr up to the overtime limit of 40 hrs whereupon he gets paid £5.00 per hr. Manually calculate his wage for that short week.

· 2. Manually calculate his wage if he works 45 hrs.

· 3. Make an Excel formula using an IF statement to automatically give the number of overtime hrs if the number of hrs worked is entered.
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· 4. Make another Excel formula using an IF statement to automatically give the number of ordinary hrs if the number of hrs worked is entered. (You could also use the MIN function)
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· 5. Finally, place a formula in G2 which automatically calculates his total weekly wage.
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Data Tables:

We have a simple formula which calculates the interest of 1000 at 10% as below.
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To Make a Data Table
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If the Data To Be Input is in a Row Instead of a Column
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Two Dimensional Data Table
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The 2-D Data Table appears.
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Lookup and Reference functions

https://support.office.com/en-us/article/Lookup-and-reference-functions-reference-8aa21a3a-b56a-4055-8257-3ec89df2b23e
	Function 

	Description

	ADDRESS function 

	Returns a reference as text to a single cell in a worksheet


	AREAS function 

	Returns the number of areas in a reference


	CHOOSE function 

	Chooses a value from a list of values


	COLUMN function 

	Returns the column number of a reference


	COLUMNS function 

	Returns the number of columns in a reference


	FORMULATEXT function 


	Returns the formula at the given reference as text


	GETPIVOTDATA function 


	Returns data stored in a PivotTable report


	HLOOKUP function 

	Looks in the top row of an array and returns the value of the indicated cell


	HYPERLINK function 

	Creates a shortcut or jump that opens a document stored on a network server, an intranet, or the Internet


	INDEX function 

	Uses an index to choose a value from a reference or array


	INDIRECT function 

	Returns a reference indicated by a text value


	LOOKUP function 

	Looks up values in a vector or array


	MATCH function 

	Looks up values in a reference or array


	OFFSET function 

	Returns a reference offset from a given reference


	ROW function 

	Returns the row number of a reference


	ROWS function 

	Returns the number of rows in a reference


	RTD function 

	Retrieves real-time data from a program that supports COM automation


	TRANSPOSE function 

	Returns the transpose of an array


	VLOOKUP function 

	Looks in the first column of an array and moves across the row to return the value of a cell



	
	


Choose



Row and Column
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Address 
Returns a physical address.

Offset


OFFSET(reference, rows, cols, [height], [width])

Optional [height] & [width]s refers to size of the range which is offset.
eg Make a formula which sums 3 values which are offset 2,1 from cell B3 and are of size 3,1.
=OFFSET(B3,2,1,3,1)
[image: image22.png]fe | =SUM(OFFSET($BS3,2,1,3,1)





Index
: 
Reference an element in an array by its indices (Row, Column).

[image: image23.png]=INDEX(C1:E3.2,1)





we can just specify ONE index in a row (or column) say C1:C3 eg =INDEX(C1:C3,2) would return 4 in this case. (2 is the row number here.)
Index     contd. This also illustrates an   Array Formula

 












We could of course the use the SUM formula on this reference above. eg 
=SUM(INDEX(F2:G3,0,1)   ->  3


The “reference” form of Index:

If multiple areas are specified:



result will be:  row 2 column 1 of the 2nd area -> 2.

Match

MATCH finds the relative position of an item in a range.
=MATCH(23,C1:C4,0) 0 means that an exact match must be found.
 (The data need not be sorted.)



=MATCH(23,c1:c4,1) : The 1 (or omitted ie =MATCH(23,C1:C4) ) means that a value less than what we are looking for will suffice. The data must be sorted in ascending order,. 
So if we look for 24:


=MATCH(…………..-1) : The -1 means that a value bigger than what we are looking for will suffice. The data must be sorted in descending order!. So if we look for 24:


Exercise: Use Match and Index to emulate this VLOOKUP below.




Do this in three stages:

1. First find the row number of jo in the first column using Match.





2. Now use this value of 2 in the above Index formula.




3. 
3.     We can combine them into one formula:

ans:
 =INDEX(B1:B3,MATCH("jo",A1:A3,0)) (0 indicates exact match – or you could omit it.)


so this is (almost – see below) the equivalent of the VLookup above
Better Method: which uses the whole table reference (as does VLOOKUP).


=INDEX(A1:B3,MATCH("jo",A1:A3),2)


If the columns are swapped as shown below  Index-Match can work “backwards” (which VLOOKUP can’t!). Change to =INDEX(A1:B3,MATCH("jo",B1:B3),1)



So VLOOKUP effectively looks backwards.

Median



Mode is the most frequent.

Average or mean

Abs ignores sign

Indirect
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IsError
Returns the logical value TRUE if value refers to any error value, such as #N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or #NULL!; otherwise, it returns FALSE

IFError

Exercise
Use IsError to cover up a VLookup when the lookup value is not found

ans:

=IF(ISERROR(VLOOKUP(E3,$B$3:$C$11,2,FALSE)),"",VLOOKUP(E3,$B$3:$C$11,2,FALSE))



Count
Count counts the number of numbers.



See also CountBlanks, CountA (Counts non-blanks), 
Countif




Countifs
CountIfS is the same as CountIf but it can operate across multiple ranges.
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(See Help on Microsoft CountIfs for further examples)
SumIf





more complex:




SumIfs 
See MS Help.

Adds the cells in a range (range: Two or more cells on a sheet. The cells in a range can be adjacent or nonadjacent.) that meet multiple criteria. For example, if you want to sum the numbers in the range A1:A20 only if the corresponding numbers in B1:B20 are greater than zero (0) and the corresponding numbers in C1:C20 are less than 10, you can use the following formula:

=SUMIFS(A1:A6, B1:B6, ">0", C1:C6, "<10")




Concatenate

&


“Concatenate” does the same job as the ampersand(&).

Date and Time Functions
· DATE function Returns the sequential serial number that represents a particular date.

· DATEDIF function Calculates the number of days, months, or years from one date to another date.

· DATEVALUE function Converts a date in a cell that uses the Text cell format into a sequential serial number that you can use in date calculations.

· DAY function Returns only the day of the month of a date. The day is given as an integer, ranging from 1 to 31.

· DAYS360 function Calculates the number of days from one date to another date based on a 360-day year (twelve 30-day months), which is used in some accounting calculations. Use this function to help compute payments if your accounting system is based on twelve 30-day months.

· EDATE function Returns the serial number that represents the date that is a specified number of months before or after start_date. Use EDATE to calculate maturity dates or due dates that fall on the same day of the month as the date of issue.

· EOMONTH function Returns the serial number for the last day of the month that is a specified number of months before or after start_date. Use EOMONTH to calculate maturity dates or due dates that fall on the last day of the month.

· HOUR function Returns only the hour of a time value. The hour is given as an integer, ranging from 0 (12:00 A.M.) to 23 (11:00 P.M.).

· MINUTE function Returns only the minute of a time value. The minute is given as an integer, ranging from 0 to 59.

· MONTH function Returns only the month of a date represented by a serial number. The month is given as an integer, ranging from 1 (January) to 12 (December).

· NETWORKDAYS function Returns the number of whole working days from start_date to end_date. Working days exclude weekends and any dates identified in holidays. Use NETWORKDAYS to calculate employee benefits that accrue based on the number of days worked during a specific term.

· NETWORKDAYS.INTL function Returns the number of whole workdays between two dates.

· NOW function Returns the serial number of the current date and time. If the cell format was General before the function was entered, the result changes the cell formatting to Time.

· SECOND function Returns only the second of a time value. The second is given as an integer, ranging from 0 (zero) to 59.

· TIME function Returns the decimal number for a particular time. If the cell format was General before the function was entered, the result changes the cell formatting to Time.

· TIMEVALUE function Returns the decimal number of a particular time represented by a text string. The decimal number is a value ranging from 0 (zero) to 0.99999999, representing the times from 0:00:00 (12:00:00 A.M.) to 23:59:59 (11:59:59 P.M.).

· TODAY function Returns the serial number of the current date. If the cell format was General before the function was entered, the result changes the cell formatting to Date.

· WEEKDAY function Returns the day of the week corresponding to a date. The day is given as an integer, ranging from 1 (Sunday) to 7 (Saturday), by default.

· WEEKNUM function Returns a number that indicates where the week falls within a year. The week is given as an integer.

· WORKDAY function Returns a number that represents a date that is a specified number of working days before or after start_date. Working days exclude weekends and any dates identified as holidays. Use WORKDAY to exclude weekends or holidays when you calculate invoice due dates, expected delivery times, or the number of days worked.

· WORKDAY.INTL function Returns the serial number of the date before or after a specified number of workdays with custom weekend parameters.

· YEAR function Returns the year corresponding to a date. The year is returned as an integer, ranging from 1900-9999.

· YEARFRAC function Calculates the fraction of the year represented by the number of whole days from start_date to end_date. Use YEARFRAC to identify the proportion of a whole year's benefits or obligations to assign to a specific term

Logical functions
· AND function Returns TRUE if all of its arguments are TRUE

· FALSE function Returns the logical value FALSE

· IF function Specifies a logical test to perform

· IFERROR function Returns a value that you specify if a formula evaluates to an error

· NOT function Reverses the logic of its argument

· OR function Returns TRUE if any argument is TRUE

· TRUE function Returns the logical value TRUE

eg WeekDay
Round
Rounds a number to a specified number of digits. 


See Roundup, Ceiling, Floor etc

IsText
Returns the logical value TRUE if value refers to text; otherwise, it returns FALSE. 


IsNumber

Mid
Returns a specific number of characters from a text string, starting at the position that you specify, based on the number of characters that you specify.


Right


Left
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Len
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Find
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Exercise

Extract the First Name and Surname from a fullname eg Jack Robinson. It must work for any name eg Thenga McKenna. Hint: Find the position of the space first.
Outlining

· Make this table.



To Outline Automatically

· With the cursor in the above list…




Note that automatic outlining will work so long as we have a formula which is doing the totalling.  

Ungroup them. To Ungroup we need to …

To Outline the Rows Manually






Clear Outline from The Ungroup Ribbon item as before.

To Outline the Columns Manually
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True and False


Or

We have produced a Truth Table for the OR.

And
Replace the OR formulas above with AND ie =AND(A1,B1) etc and produce the truth table.

Not

· Exercise:  Use on If and an Or to get a NOR (not Or)
Macros on Excel 2007/2010
We must first make sure that the Developer Toolbar is on the menu as follows. 



or…











or..
· For 2007:




· For 2010, choose Customize Ribbon and then check the Developer check box and click OK.

To Record a Macro 

For  Excel 2070 or 2010:





· Choose Bold Italics etc.



· Now highlight some text and press Ctrl-z. The text will be formatted Bold Italic or whatever you recorded.

To Write Some VBA
· Choose the Developer tab.








We can now write our VB code









Further : Read Excel VBA in Easy Steps by Ed Robinson!

http://www.amazon.co.uk/Excel-VBA-Easy-Steps-Robinson/dp/1840782714
Math in Excel

Multiplication/Division takes precedence over Addition/Subtraction.

· Try these:

= 2 * 3 + 4

 -> 10

= 2 + 3 * 4

 -> 14

= 4 / 2 + 3 

 ->  5

= 4 / 2 -  3 

 -> -1

Brackets take precedence over everything. ie Do them first.

(Strictly speaking brackets should be called parentheses.)

=  2 * (3 + 4)

 -> 14

= (2 * 3) + 4

 -> 10       (Brackets makes no difference in this case)

=  4 / (1 + 3)

 ->   1

=  2 * (3 + 4)

 -> 14

Raising to a power:

 eg  23  is written in Excel as  =2^3 which of course gives 8. (Shift-6 will give you the caret.)

Exponentiation as it is called takes precedence over * and /.

eg in Excel (and in mathematics):         = 4 * 2^3   will give  32.

=2^

Percentages
1. To Convert a Decimal into a Percentage multiply by 100.

eg .50 as a percentage is 50%. 

In Excel: = .50 * 100 -> 50.

(In Math to multiply by 100 we of course move the decimal place 2 places to the right 

so .50 -> 50.)

· Try these: Convert to Percentage

.23
->      ……

.40
->

.4  
->

.05
->

.12
->

· In Excel we can achieve the same effect by formatting as a percentage. (See previous notes on this). Try the above by formatting the fraction as a percentage.

 
2. To Convert a Percentage into a Decimal divide by 100.

· Try the above in reverse.


3. To Find the Percentage of a Number
eg Find 50% of 200.

In Math the formula is 


[image: image30.wmf]
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 so the answer should be 100.

So the rule is: Divide the percentage by 100 (ie convert it to a decimal) and then multiply.

· Try these. Find

20% of 500  = …..

10% of480   =

15% of 200  =

12% of 240  =

 6% of 48     =

4 .To find one number as a Percentage of another.
eg What pecentage is 20 of 40?

Rule: Divide the first number by the second and multiply by 100

[image: image32.wmf]100
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   -> 50 ie 50%

In Excel: = 20/40 * 100.

BUT in Excel be could also do = 20/40 and the FORMAT the result as a percentage.

Note that the CONTENTS of the cell will be REGARDED as .5 even though it APPEARS as a percentage.

[image: image33.png]



· Try these. Find

20 
as a percentage of 50. 

50 
as a percentage of 200. 

10 
as a percentage of 400. 

  5 
as a percentage of 40. 

12.5 
as a percentage of 125. 

5. To Increase by a Percentage: In 2 steps first.
eg Increase 200 by 20%

6. To Increase by a Percentage "in one go":

eg Increase 200 by 20%

7. Repeat the above two for a DECREASE.

Difficult: 7. To Find the Original after it has been increased by a Percentage
eg 240 is the result of a 20% increase. What was the original amount?

8. As above but DECREASED,

eg 80 is the result of a 10% decrease. What was the original amount?

9. Very difficult To find the overall % inc after increasing by a percentage TWICE.

200 is increased by 10% and then increased by 20%. What is the overall % incrrease?

Percentages in Excel.
Firstly note that when w enter a fraction , behind the scenes it is a decimal.

eg type 10%
[image: image34.png]



     If we toggle Ctrl-grave we can see that it is really .1.
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There are two ways of looking at %  calculations:

The Excel way and the Math way.

eg what % is 20 of 200 

 (ans 10%)

First:

[image: image36.png]



Now we can proceed in 2 ways:

1. The Math way. Multiply by 100
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Note that the answer is 10 and not .1. (This will be important if we use this 10 in future calculations)

2. The Excel way Format as a %
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To Allocate a Number Set to Different Cells
 ie split a group of numbers in one cell to many cells
eg if these numbers are in ONE cell. (Separated by spaces)
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result:
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Future Value, Present Value,  NPV and IRR (Internal Rate Of Return)
Simple Interest

Find the interest on 100 @ 10% pa for 1 year.

Find the total amount after 1 year

What is the formula

Compound interest

Lets say that the £110 is invested for one more year at the same interest rate.

How much will you have at the end of the 2nd year?

Start again

100 is invested at 10% for 2 years. How much will you have at the end of the 2 years.

What is the quick formula?

The amount that you will have at the end of the 2 years is also called the 

Future Value

eg the above question would read “Find  the FV of 100 @ 10% pa for 2 years “


We can use the Excel FV function although it is a bit tricky.

[image: image42.png]FV(10%,2,0,100)
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Just to confuse things this will also give a negative amount:

[image: image43.png]-£121.00





so we need to either put a minus in front   =-FV(10%,2,0,100) 

or use the ABS formula.       =ABS(FV(10%,2,0,100))
Present Value
Present Value Is Future Value (or Compound Interest) in reverse.

eg the FV of 100 at 10% pa in 2 yrs time is 121 means that the
PV of 121 in 2 years’ time is 100. (Note the slightly strange way that this is expressed.)

We know the formulas for our FV is

The formula for PV is this formula “backwards” ie

Ex:
1.  Find the PV of 200 in 2 yrs time.

2.  Find the PV of 400 in 3 yrs time.

3.  Find the PV of 200 in 2 yrs time and 400 in 3 yrs time.

This total is called the Net Present Value (NPV)

NPV=


	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


We can use Excel’s NPV function to calculate this directly.

=NPV(C1,B2,B3,B4) but we need to place a 0 in cell B1 for year 1 since Excel’s NPV assumes annual increments.
The IRR (internal rate of return) is the interest rate for which the NPV = 0.
=IRR(B1:B4) eg for -500 in cell B1(initial investment)   ->   7.1%

RANK   





addressesExpt.xlsm
	7
	
	RANK.EQ
	
	RANK.AVG
	 

	4
	Rank of the 4 in the list ->
	3
	=RANK.EQ(4,$A$1:$A$5,1)
	3.5
	=RANK.AVG(4,$A$1:$A$5,1)

	4
	Rank of the 7 in the list-> 
	5
	=RANK.EQ(7,$A$1:$A$5,1)
	5
	=RANK.AVG(7,$A$1:$A$5,1)

	1
	
	
	
	
	
	
	

	2
	
	
	(In all cases there is nothing with rank of 4)
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	


Explicit Intersection


Or name row 5 as IBM and column S as PX_FIRST and then use the formula


Drop-Down List




Charts cont’d

Make this chart of the number of bears seen at the National Park.

ie Select data ,Inset, Column chart. 


	
	jan
	feb
	mar
	apr
	may
	total

	bears
	32
	45
	23
	34
	22
	156
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Right-click on the chart and choose Select data, The Select Data Source dialog box appears:







Add the series for the lions and tigers as shown below: (The data can be copied from here.)
	
	jan
	feb
	mar
	apr
	may
	total

	bears
	32
	45
	23
	34
	22
	156

	lions
	23
	54
	65
	23
	54
	219

	tigers
	38
	54
	76
	21
	45
	234

	total
	93
	153
	164
	78
	121
	609


Make the chart as before. 

The number of animals by month.

Right-click on the chart and choose Select data, The Select Data Source dialog box appears:











The number of months

per animal.
To manually edit the series etc









Each series could be a different chart type. eg line or column:
To change the chart type
For the exercise we will change the Feb series to a Line type.












The change the Chart type for all series
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Pies & Donuts
Can only do one Pie series at a time. (So use stacked Pies for more than one series?)
https://wmfexcel.com/2017/02/25/want-some-pies/

To change individual sectors




Can have concentric Donut:

Plot Area and Chart Area







To format horizontal axis select axis do this:

We have produced an embedded chart.
    Chart sheet:



To Plot a Line

X-Y scatter graph! 





Data Labels

To add data labels we can right-click on the chart…








Excel 2007: Select the range A1:A3. On the Formulas Tab on the ribbon. 





		Choose Define Name.		Type in a name for your range and click OK.





�	�


 





Note that the name Sales appears at the top left – in Name Box (when the range is selected.) (From now on, if we wish to select this range we can choose Sales from this drop box.)








It is also possible to name a range by simply selecting the range, clicking in the Name Box and typing the name.


 Don’t forget to press Enter! Try it.





Easy way to name a range: 


1. Highlight your range. 


2. Simply type the name of your range into the Name box. 


3. Press Enter (Don’t click away to enter).





The sum of the cells in the range Sales will appear in C4.





Ctrl-Shift F3 will deal with a column of names in one go!  (Select Left Column)





… Excel has a guess at what you want to call it!





Don’t select the name or else the old range will also be selected!





.. take care to re-type the name in the Define Name dialog box .





FormulasTab on the ribbon. 


Insert Function..





�














Click the Function Wizard button.








Select cell C4.








Select Statistical.








Select AVERAGE.








Click Finish.








Click OK.








The range of numbers to be averaged should appear here. If it doesn’t, click  the little coloured square (this removes the dialog box so that you can see the range required on the s/sheet itself in order to select them To return to the dialog box, click  the little coloured square again..








(Note the appearance of the formula - which might just as easily be typed in! )








The average of the 3 numbers which is 2 should appear here.








Tip of the day: Ctrl-Shift-F3 will use column headings to create many names.





Formulas Tab


Insert Function 

















Type the interest rate per period  ie =10%/12.





Select the cell where you wish to answer to appear here and then click the function wizard button     . �





Select Financial.





Select PMT.





Click OK.





Alternatively you could just type in :


=PMT(C2,C3,C4)














Click in the respective boxes and corresponding s/sheet cells to include the references as shown.





Click OK.





The repayment should be calculated. (Red indicates that a payment must be made.) (It is common practice to make the loan amount negative ie -2000 in this case.)





Excel 2007 Page Layout  Tab





�





Click arrow to get the


     Page Setup dialog box.. 

















� EMBED PBrush  ���





Drag a fill handle until we reach about cell K60.





� EMBED PBrush  ���





Page breaks are indicated by the dotted lines.





� EMBED PBrush  ���





Choose Fit to 1 by 1.





Choose the Review tab and then Protect Sheet. ( There is also the option to protect the whole Workbook.)








Protection and..





.. uncheck the Locked property for these cells.





Try changing any other cell.





Note the drop-downs for the Rows and Columns. Try them. 





Note that in the pivot table, New York  and London are referred to as Fields whereas Clothing and Food which are "headings" which were taken from the body of the table are known as Items.





Change the 1200 to say 15000 in the original table of data.





Type in a new row of data. We now wish to update the pivot table.





With the cursor in the pivot table, choose Options, Data tab, Change Data Source from the context Ribbon.

















Update to the new range and then click OK.

















The pivot table  is updated.





Right click on Store and choose Add to Report Filter.














(Alternatively just drag the field here.)


.














To select a different "page" select  London or New York, and click OK.





At the moment these are totals (sums).


Say we wanted to find the maximum in each respective row and column.





Right-click in the pivot table  and choose Summarize Values  By and then choose Max for example.














This is now the maximum value in the row etc.





� EMBED PBrush  ���





We wish to insert a VAT column for Food.





First make sure that your cursor is in the pivot table. – actually in an Item heading (ie Food) . From the Options tab on the (Pivot Table Tools ) Ribbon, choose


   Fields Items & Sets .., Calculated Item.. 








Give our new heading a name.





(Rather than type “Food” when constructing the formula it may be easier to double-click on it here.)





Click OK.





The new field is inserted.





To remove the calculated field, From the Options tab (make sure that your cursor is in the pivot table) – actually the cursor needs to be in Item heading( ie Food) 


On the ribbon, choose Fields .., Calculated Item.


and then the  Delete button and click OK.








Similar for 2007.











Choose the Dept drop down.





� EMBED PBrush  ���





Uncheck the Clothing check box.





Click OK.





� EMBED PBrush  ���





� EMBED PBrush  ���





Hide Detail when we have more than one row heading or more than one column heading.


See page 514 ? Excel manual.








Its easier just to type it in!


Type it in the formula bar.





Choose Field Settings…





Change the name and click OK.





� EMBED PBrush  ���





� EMBED PBrush  ���





The new group heading (Group1) appears.


Change it to Consumables. (Click on it and change it in the formula bar. (See below for the result)





Note the appearance of a new field – a 2 is appended - in this case to give Dept2? 





Double-click on the group heading (Consumables)….





(Alternatively, use the Hide Detail menu command from the short cut menu or the Hide Detail button on the pivot table toolbar.)





May not be the same in 2007+





…the two columns are summarised.





.. and the clothing column appears in its “hidden” format!





May not be the same in 2007+





(Right-click and choose Field Settings. Choose


Layout & Print then “Show item labels in tabular form.)





� EMBED PBrush  ���





We wish to remove these subtotals.





� EMBED PBrush  ���





Right-click on one of them and choose Field Settings…





� EMBED PBrush  ���





…it has a Subtotals section.





Choose None.





Click OK. 





Choose say Store and then click OK.





When the slicer appears, choose say London.





(We get a pivot table for free.)





Pivot chart.





eg If 45 is entered here, 5 must appear here.





eg If 35 is entered here, 0 must appear here.





eg If 45 is entered here, 40 must appear here.





eg If 35 is entered here, 35 must appear here.





Excel 2007: Data tab on the ribbon. 


What If Analysis.


�

















We wish to "plug" values into this cell to see the effect of different interest rates.  Such values are provided by a Data Table.  (This cell is called the Input Cell.)





First provide the range of values that we wish to substitute.  They could be in a row or column.  We have chosen to use a column.  





Secondly – to the top-right of our column of values, copy the formula as shown which serves as an example of the calculation.





Select the prospective data table. 





From the Ribbon, choose Data, What If Analysis, Data Table…





Since the values that we wish to substitute into the input cell are in a column, choose Column input cell: and choose the cell into which we wish to successively input the values. 





Click OK.





The data table containing the corresponding results appears.  (It may be  aesthetically desirable to hide the "example formula" in E4.)





Why use data tables? You know very well that you can drag formulas, but the problem is that you can only drag “parallel to the data”. Data tables allow you to drag “at right angles” to the data!





Another point of using data tables: For a 1-D data table. The formula that we wish to “drag” may be remote from where we wish the result to appear.





Indicate that the data is being substituted from a row into the input cell by choosing Row input cell:.





The "example formula" must be one to the left and one below the data.





Now we really see the use of data tables. Think what it would take to construct this 2-D table if we didn’t use data tables.





We wish to show the effect of changing the principal amount as well as the interest rate.





Select this area and copy the formula into the top-left cell of our table, select the table and then choose Data, What If Analysis,  Data. Table.. from the Ribbon.





Choose B1 as the Column Input cell. (Think “across”.)





Choose A1 as the Row Input cell. (Think “down”.)





A1 is the Row Input cell and B1 is the Column Input cell.








Wrong: Should be other way round.





Click OK.





It chooses the 2nd option which is tue.





The value which is at offset 1 row and 1 column from B2 is 43.





The sum of the 3,1 column of  numbers which are located at  offset (2,1) from B3.





Index gives a value.











The 1, 0 means every column element in the row 1 is displayed.





“0 means every.” 





=INDEX(F2:G3,2,0) Every element in row  2 would be displayed..





An Array formula is mainly used when we have a series of values resulting.


They are apparently sometimes called CSE (Control-Shift-Enter) formulas.








Enter this as an array formula. (Ctrl-Shift-Enter.) 





0, 1  means every row element in the column 1.

















…then as well as specifying the row, column  eg row 2 column 1…





we need to specify which area eg area 2.








This is the 2nd area specified in the above formula ie Area 2.








Row 4 is returned because 23 is an exact match for 23 in the formula.














Row 3 is returned because 23 is the first number less than the 24 in the formula.














Row 1 is returned because 25 is the first number bigger than the 24 in the formula.











(Remember that False indicates that an exact match must be found.)





Remember: ) 0 means that an exact match must be found or use MATCH("jo",A1:A3).





jo is in row 2.





We are here using the result of our MATCH which is in D2.





Result: 20 is in row 2 of the 2nd column.





2 indicates the column number that INDEX looks in. ie 2nd row 2nd column.





Maybe better start here:


=INDEX(A1:B3,2,2) means find the element of A2:B3 in the 2nd row and 2nd column. ie 20.Then MATCH("jo",A1:A3,0) provides the row  2.





ie 2nd row 1st column.





The middle value when arranged in ascending order. Sort them to show that 2.2 is then the middle value.





Returns the value that is in c2.





Help


To get Help highlight and press F1 or click the fx.


Commas in formulas mean placeholder for omitted arguments.





There are 3 numbers (and one text value which is not counted.)





Note the inverted commas.





There are 3 numbers greater than 5.





Remember the quote marks for the criterion!





Note that CountIfS works across the column in this case ie ed must also have 10 to be counted ie ed AND 10.





There is one


 “ed” and 10


on the same row.





eg =COUNTIFS(B2:B5,"=ed",C2:C5,"=12") would produce 0.





Remember the quote marks for the criterion!





Only numbers bigger than 5 are summed.





Remember that the range to be summed comes last.





Only ed’s numbers from range A1:A4 are summed.





ie sum numbers in column A which have a positive number in column B AND a number <10 in Column C.


ie


2	4	2


1	6	1


3








� HYPERLINK "https://support.office.com/en-ie/article/sumifs-function-c9e748f5-7ea7-455d-9406-611cebce642b" �https://support.office.com/en-ie/article/sumifs-function-c9e748f5-7ea7-455d-9406-611cebce642b�








� EMBED PBrush  ���





Insert the formula


= C4 + C6 to find the grand total here.





� EMBED PBrush  ���





… from the Data tab, Data Tools group , choose Group and then Auto Outline.





� EMBED PBrush  ���





Click these to collapse to the total for the New York etc.





Ungroup, Clear Outline.





First select the rows that we wish to group 





… from the Data tab, Data Tools group , choose Group and then Group.





Make sure that Rows is checked and then click OK.





First select the two columns.





… from the Data tab, Data Tools group , choose Group and then Group.





Choose Columns and click OK.





We can click these to see the effect.





Type these True False values into columns A and B.





Type in this formula and drag down.





Click the Office button in 2007





In 2010 click File.





Choose Excel Options.





Options.





Check Show Developer tab in Ribbon.





Choose This Workbook.





Choose Ctrl-z to run the macro then click OK.





For the moment don’t click anywhere else in the spreadsheet. ie don’t change the selection else the recorder will record this as well!





Stop Recording.





Click on the Insert button. (Don't confuse this with Insert on the menu.)





Click on the Command Button button. (Not the Form Controls button.)





Draw a button on the sheet and double-click on it to write some code etc.





Click the Visual Basic tab.





Write this code.





Click the Run button.





3 is placed in Cell(1,1).





Beware of dividing lines: 


It is very much overlooked that in math a long dividing line has the same effect as a bracket.


eg      in Math we have    � EMBED Equation.3  ��� = 1





So the (long) dividing line has the effect of brackets ie the above is equivalent to:


			� EMBED Equation.3  ���= 1


But in Excel we don’t have a long dividing line. So if we need to put this into Excel we must use a bracket to emulate the effect of the long dividing line ie 





			=4/(2+2)     (If you try it without the brackets, what will you get?)


So to cut a long storey short : If you were asked to enter � EMBED Equation.3  ��� into Excel


 you would enter =4/(2+2) to give the correct answer of 1.





(The other way of doing it would be to Enter = 4/2/2. This means Divide the 4 by the first AND THEN divided this result by the second 2.)





(The same problem as above exists when using a hand held calculator. - and as someone would say - "no a lot of people know that" esp  A-level math students.)





Note that the contents of the cell can still be regarded as the decimal.


eg the .23 formatted as a decimal will be 23% but it is still regarded by Excel as .23.


It only PRESENTED TO YOU as a percentage.





Find the percentage increase.


eg 200 is increased to 240. What is the % increase?





eg 200 is decreased to 180. What is the % decrease?








This is true whether we originally formatted .1 as a decimal or we just typed 10%.





It is important to realize that the result is .1 and not 10. answer is 10 and not .1. (This will be important when using this in future calculations.








Data,Text to Columns.





Choose Delimited and then the space for the delimiter (and Next).





Choose Finish





The total is the NPV.





RANK.EQ() = the old RANK() in prev versions





(The data can be copied from here.)








It is quite obvious in this case that the Horizontal axis is the months.





The legend is taken from the series.





The number of bears here is called a Series. A series is plotted on the vertical axis.





Series: vertical axis.





You may wish to copy and paste our data as the transpose.


(Paste Special, Transpose) and make the chart. The same chart should result.








Click to switch the axes.





Note the extra series we now have.





   The Series are now the months.





Click Edit





The series name is cosmetic (in this case “jan”).





Edit this to include more values in the series for example.





Select the Feb series and right-click on it.





Choose Change Series Chart Type.





Note carefully how the corresponding data is also selected.





Choose Line and OK.





(For what it’s worth) the 2nd Series (jan) has been plotted as a Line.





Right-click on either the Plot area (the inside box) or the Chart Area (the container) and choose Change Chart Type.





Choose Stacked Column and OK.





ALL the series have been converted to stacked.





Data.





Plot Area.





Chart Area.





We may also place a chart on separate Chart Sheet as follows: Select the chart and from the menu choose the Design tab and then Move Chart Location. Choose a new sheet:





�









































Only a (separate) chartsheet as shown here can have events:


ie the chart as produced above cannot (Try double-clicking on the above chart!) - and to call these events we need to place an old-fashioned Forms button on the chart at that!


�








� EMBED PBrush  ���





Remove the other (x) series and set the x-values to column A.





� EMBED PBrush  ���





… and choose Add Data Labels.





To modify the label's formatting etc right-click on a label and choose Format Data Series and then use the dialog box below to modify.
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